Preface

The User's Guide explains the utility MegaRAID Storage Manager™ to be used for “LSI Logic Embedded MegaRAID(tm)”, “N8103-91 Disk Array Controller(Internal SAS HDD)”, “N8103-90 Disk Array Controller(External SAS HDD)”, “N8103-99 Disk Array Controller(0ch)”, “N8403-019 Disk Array Controller” and “LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB”, installed in NEC Express5800 server.

The guide is intended for persons who are familiar with Windows functions and operation methods. For details on or unclear points on Windows operation, see Windows Online Help and manuals.

When using MegaRAID Storage Manager™, first read the User's Guide provided with the server as well.

Trademarks:

LSI Logic, its logo, iBBU, MegaRAID, and MegaRAID Storage Manager are trademarks or registered trademarks of LSI Logic, Inc. of the U.S.A.

NEC ESMPRO and NEC EXPRESSBUILDER are registered trademarks of NEC Corporation.

Microsoft, its logo, Windows, Windows Server and MS-DOS are worldwide registered trademarks of Microsoft Corporation of the U.S.A.

All company names and product names mentioned herein are trademarks or registered trademarks of their respective companies.

Notes:

(1) No part of this manual may be reproduced in any form without the prior written permission of NEC Corporation.

(2) The contents of this manual may be revised without prior notice.

(3) The contents of this manual shall not be copied or altered without the prior written permission of NEC Corporation.

(4) All efforts have been made to ensure the accuracy of all information in this manual. If you notice any part unclear, incorrect, or omitted in this manual, contact the sales agent where you purchased this product.

(5) NEC assumes no liability arising from the use of this product, nor any liability for incidental or consequential damages arising from the use of this manual regardless of Item (4).

© NEC Corporation 2006
Contents

1. Overview ................................................................................................................................. 1
   1.1 MegaRAID Storage Manager™ ............................................................................................ 1

2. Installing and Uninstalling MSM .......................................................................................... 3
   2.1 MSM Operation Environment (Server Specification) .......................................................... 3
   2.2 Installing and Uninstalling MSM in Server ....................................................................... 4
       2.2.1 Installing MSM to Server ......................................................................................... 5
       2.2.2 Uninstalling MSM from Server ............................................................................... 7
   2.3 MSM Operation Environment (Management PC) ............................................................. 8
   2.4 Installing and Uninstalling MSM in Management PC ...................................................... 8
       2.4.1 Installing MSM to Management PC ......................................................................... 9
       2.4.2 Uninstalling MSM from Management PC ............................................................. 11

3. Operation ............................................................................................................................... 13
   3.1 Starting MSM .................................................................................................................... 13
       3.1.1 Controlling MegaRAID Storage System with Local/Remote Computer .................. 14
   3.2 MSM Operation Screen .................................................................................................... 16
       3.2.1 Menu Bar ................................................................................................................ 17
       3.2.2 Physical/Logical View ............................................................................................ 19
       3.2.3 Properties/Operations/Graphical View .................................................................... 25
       3.2.4 Event Viewer ......................................................................................................... 32
   3.3 Creating and Deleting Logical Drive (Array) .................................................................... 33
       3.3.1 Creating Logical Drive ........................................................................................... 34
       3.3.2 Deleting Logical Drive ............................................................................................ 41
   3.4 Check Consistency Feature .............................................................................................. 42
       3.4.1 Executing Check Consistency .................................................................................. 42
       3.4.2 Canceling Check Consistency .................................................................................. 45
   3.5 Patrol Read Feature .......................................................................................................... 46
       3.5.1 Manual Execution of Patrol Read ............................................................................. 46
       3.5.2 Scheduling Patrol Read ........................................................................................... 48
   3.6 Rebuild Feature ................................................................................................................ 50
       3.6.1 Hot-swap Rebuild ..................................................................................................... 51
       3.6.2 Hot-spare Rebuild .................................................................................................... 52
   3.7 Reconstruction Feature .................................................................................................... 53
       3.7.1 Executing Reconstruction ....................................................................................... 53
   3.8 Help .................................................................................................................................. 58

4. Miscellaneous Information .................................................................................................... 59
   4.1 Supported function of MegaRAID Systems ................................................................. 59
   4.2 How to confirm the type of Hot Spare Disks ............................................................... 60

5. CAUTIONS AND RESTRICTIONS ..................................................................................... 61
   5.1 Common Cautions and Restrictions for MegaRAID Storage Systems(SAS/SATA) ......... 61
   5.2 Cautions and Restrictions for N8103-90 Disk array controller(External SAS HDD) and N8103-91 Disk array controller(Internal SAS HDD) .................................................. 64
   5.3 Cautions and Restrictions for LSI Logic Embedded MegaRAID™ .................................. 66

Appendix A Report Monitoring ................................................................................................. 67
(This page is intentionally left blank.)
1. Overview

1.1 MegaRAID Storage Manager™

MegaRAID Storage Manager™ (hereafter abbreviated for MSM) is an application that locally or remotely monitors and manages the MegaRAID Storage Systems(SAS/SATA).

MegaRAID Storage Systems(SAS/SATA) are following systems.
- LSI Logic Embedded MegaRAID(tm)
- N8103-90 Disk Array Controller(External SAS HDD)
- N8103-91 Disk Array Controller(Internal SAS HDD)
- N8103-99 Disk Array Controller(0ch)
- N8403-019 Disk Array Controller
- LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB

MSM has the following features:
- Flexible system management
  MSM provides a system using MSM with N-to-1 management. In the environment enabling communication through TCP/IP, more than one system can be managed at a time by remote management.
- Feature of creating or deleting the following arrays (packs) on the graphical operation screen
  MSM allows the following arrays to be created:
  - RAID 0 (data striping with more than one hard disk drive)
  - RAID 1 (data mirroring with two hard disk drives)
  - RAID 5 (Data and parity striping with more than two hard disk drives)
  - RAID 1 spanning (Same as RAID10. Data mirroring and striping with more than three hard disk drives)
  - RAID5 spanning (Same as RAID50. Data striped including parity and striping with more than five hard disk drives)

**IMPORTANT:**
Support RAID Levels depends on MegaRAID Storage Systems(SAS/SATA). Please check Section "4.1 Supported function of MegaRAID Systems".

- Check consistency feature for checking array consistency
  MSM supports the check consistency feature for checking consistency. MSM also supports the feature of recovering data automatically if the check consistency feature detects inconsistency.
Auto array rebuild feature in array degrading

MSM supports the hot-spare rebuild executed at the insertion/removal of a disk and the hot-spare rebuild in which a hot-spare disk is defined previously and used at the shift of the array to degrading state.

**NOTE:** The hot-swap rebuild is available only in a system supporting hot-swap.

To start MSM, more than 255 colors must be selected in the screen setup. If only up to 255 colors are selected, the popup requesting more than 255 colors appear and MSM cannot be started.
2. Installing and Uninstalling MSM

2.1 MSM Operation Environment (Server Specification)

The following shows the hardware and software operation environment (server specification) required to operate MSM:

- **Hardware**
  - Server: NEC Express5800/50,100,600 series server supporting following MegaRAID Storage Systems (SAS/SATA).
    - LSI Logic Embedded MegaRAID™
    - N8103-90 Disk Array Controller (External SAS HDD)
    - N8103-91 Disk Array Controller (Internal SAS HDD)
    - N8103-99 Disk Array Controller (0ch)
    - N8403-019 Disk Array Controller
    - LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB
  - Remaining capacity in hard disk drive: 60MB or larger

- **Software** (It depends on which OSs are supported in each computer.)
  - Windows Server 2003 SP1 (32bit/64bit)
  - Windows Server 2003 R2 (32bit/64bit)
  - Windows XP Professional SP2 (32bit)
  - Windows XP Professional x64 Edition
2.2 Installing and Uninstalling MSM in Server

This section describes the installation and uninstallation of MSM in an NEC Express5800 series server equipped with the MegaRAID controller.

**IMPORTANT:**

Only users authorized as administrators are permitted to install and uninstall MSM.

As premised, the software must be supported by Server.

Windows Security Warning is shown about "POPUP" as the case may be, when installing the MSM. This POPUP module is disabled in the installer of MSM, so there is no problem. This warning is not shown after the rebooting, anymore.

The dialogue of "warning of security" is sometimes indicated to installation of a "Stanby/Hibernation Lock" driver at the time of installation of MSM. When our warning was indicated, Please choose "Yes." and continue installation.

**NOTES:**

Installation of MSM in server of custom installation model
For some servers of the custom installation model, MSM may previously be installed at their purchases.

Setup of server by Express Setup
MSM can be installed by using "Express Setup", automatic installation tool stored in the NEC EXPRESSBUILDER CD-ROM coming with the purchased server. If you start the seamless setup, the dialog box appears which allows you to specify the desired application. Then select "MSM".

Install the MSM manually with the CD which attached the SAS Card, when there is no MSM installer in the "EXPRESSBUILDER" CD.
2.2.1 Installing MSM to Server

Install MSM in the following procedure:

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer.

2. Right-click [Software Setup] in the [Master Control Menu] appearing on the screen and click [MegaRAID Storage Manager]. Then the [Selecting Installation or Uninstallation] dialog box appears. Select [Installation for MSM] and click [Next].

3. The [Specifying Installation Destination Directory] dialog box appears. If you want to change the installation destination folder, click [Browse], and follow the instructions in the dialog box that appears. If the directory is specified completely, click [Next]. If the installation destination directory may not be changed, click [Next] without change.
The installation is started. When MSM has been installed, the [Setup finished] dialog box appears.

Select [Yes, I want to restart my computer now], and click [OK].

**NOTE:** After selecting system reboot at the termination of MSM installation, the background of the setup may remain as it is, rarely. If this occurs, follow the procedure below:

2. Terminate the [InstallShield - MSM] task.
3. If a dialog such as "1628: Script-base installation could not be completed" appears, click [OK] to close the dialog box.

Then reboot the system to complete the installation. Despite the operation, MSM has been installed normally.
2.2.2 Uninstalling MSM from Server

Uninstall MSM in the following procedure:

**IMPORTANT:**

Do not uninstall MSM through [Add or Remove Applications] or [Add or Remove Programs] in the Control Panel. Always follow the procedure described in this section for the uninstallation.

The popup for warning as “Application is not running”, when uninstalling the MSM. Close this popup for warning, there is no problem.

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer.
2. Right-click [Software Setup] in the [Master Control Menu] appearing on the screen and click [MegaRAID Storage Manager]. Then the [Selecting Installation or Uninstallation] dialog box appears. Select [Uninstallation for MSM] and click [Next].

![Uninstallation Confirmation dialog box]

3. After a while, the [Uninstallation Confirmation] dialog box appears. Click [Yes].

![Window Installer dialog box]

4. Uninstallation of MSM starts. The [Setup Finished] dialog box appears when MSM has been uninstalled. Select [Yes, I want to restart my computer now], and click [OK].
2.3 MSM Operation Environment (Management PC)

The following shows the hardware and software operation environment (management PC specification) required to operate MSM:

- **Hardware**
  - PC:
    - NEC Express5800/50,100,600 series.
    - PC/AT compatible machine (equipped with Intel PentiumⅢ CPU or higher)
  - Remaining capacity in hard disk drive: 60MB or larger

- **Software**
  - Windows Server 2003 SP1 (32bit/64bit)
  - Windows Server 2003 R2 (32bit/64bit)
  - Windows 2000 SP4 (Server/WorkStation)
  - Windows XP Professional SP2 (32bit)
  - Windows XP Professional x64 Edition

2.4 Installing and Uninstalling MSM in Management PC

This section describes the installation and uninstallation of MSM in a PC managing servers through a network.

**IMPORTANT:** Only users authorized as administrators are permitted to install and uninstall MSM.

**NOTES:**

For some servers of the custom installation model, MSM may previously be installed at their purchases.

Install the MSM manually with the CD which attached the SAS Card, when there is no MSM installer in the "EXPRESSBUILDER" CD.
2.4.1 Installing MSM to Management PC

Install MSM in the following procedure:

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer.
2. Run MSM.EXE contained in the following folder:
   \MSM\VIVA\MSM.EXE
3. The screen shown below appears. Click [Next].
4. The screen shown below appears. Check [I accept the terms in the license agreement] and click [Next].
5. The screen shown below appears. Check [All users] and click [Next].
6. The screen shown below appears. Click [Next].
To change the installation folder, click [Change] and specify a new installation folder.

7. The screen shown below appears. Select [Client] and click [Next].

8. The screen shown below appears. Click [Install].

9. The screen shown below appears. Click [Finish].

Now the installation is completed.
2.4.2 Uninstalling MSM from Management PC

Uninstall MSM in the following procedure:

**IMPORTANT:**
Do not uninstall MSM through [Add or Remove Applications] or [Add or Remove Programs] in the Control Panel. Always follow the procedure described in this section for the uninstallation.

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer.
2. Run MSM.EXE contained in the following folder:
   \MSM\VIVA\MSM.EXE
3. The screen shown below appears. Click [Next].
4. The screen shown below appears. Check [Remove] and click [Next].
5. The screen shown below appears. Click [Remove].

6. The screen shown below appears. Click [Finish].

Now the uninstallation is completed.
3. Operation

This chapter describes how to start MSM and how to operate MSM.

The supported features of MSM are depended on MegaRAID Storage Systems (SAS/SATA). Unsupported features are not shown in the MSM menu. See also Section "4.1 Supported function of MegaRAID Systems" for more details.

3.1 Starting MSM

This section describes how to start MSM.

IMPORTANT:
Terminate the MSM display in other than array maintenance operation.

Depending on the OS and/or color scheme you use, the screens appearing actually may be different from those shown in this manual.

NOTE: If MSM is installed in a computer in which OS supporting Windows firewall is installed, the "Important warning on Windows security" window may appear against "javaw" at the start of MSM. If this occurs, select [Release block].
3.1.1 Controlling MegaRAID Storage System with Local/Remote Computer

To control MSM with local and/or remote computers, start MSM in the following procedure to display the array configuration screen.

**NOTES:**

To control MSM with a remote computer, MSM must also be installed in the remote computer.

MSM services must operate in any systems controlled by remote computers.

If the firewall feature provided by Windows OS operates in a system controlled by a remote computer, MSM cannot be controlled by the remote computer.

In the situation, change the setting so that MSM can be controlled by the remote computer.

* MSM uses ports 3071 and 5571. MSM also uses any port numbers 32000 over temporarily. Do not block these ports.

1. Select [Start] → [Programs] → [MegaRAID Storage Manager] and click [StartupUI].

![Image](image1.png)

2. Select the server to be controlled by local and/or remote computers and click [Connect].

![Image](image2.png)

MegaRAID Storage Systems(SAS/SATA) belonging to a specific subnet are automatically displayed as candidates. For connection extending over the subnet, enter the IP address in the text box at the bottom of the screen and click [Update]. If a MegaRAID Storage system is found in the server of the specified IP address, the result will be reflected on the display.
A circle icon appears on each host in the server selection screen. The host status is shown by one of the following colors:

- **Green:** Normal operation
- **Yellow:** Occurrence of disk array degrading
- **Red:** Occurrence of configuration error

3. Operate the following on the login screen.

- In the [Login Mode] field, select [Full Access] to change the array configuration or [View Only] to see the configuration only.
- In the [User name] field, specify the name of a user authorized as an administrator for the system.
- In the [Password] field, type the password of the user specified in the [User name] field.
- Click [Login].

**NOTES:**

If [Full Access] is selected, only a single can log in to the system.

If [Full Access] is selected, only a user authorized as an administrator can log in to the system.

The names of login users and their IP addresses are recorded in the MSM log.

**IMPORTANT:**

Only local users can be specified with an Administrators authority in the [User name] field. Domain users cannot login MSM as Administrators, regardless of their authorities.
3.2 MSM Operation Screen

An example of the MSM screen is shown below (after logged in, the screen shown below appears).

MSM has four screen interfaces as follows:

1. Menu bar
2. Physical/Logical View
3. Properties/Operations/Graphical view
4. Event Viewer

The following operations are permitted for the above interfaces:

- A feature can be selected from the menu bar.
- On the Physical/Logical View, an object can be selected. Further, an item on the object can be selected by right-clicking the object.
- On the Operations tab, a feature can be selected.
- On the Event Viewer, an event can be selected. Further, an item on the event can be selected by right-clicking the event.
- The detailed information on an event can be displayed by double-clicking the event.

NOTES:

Any item grayed out in each menu is unavailable due to some reason in the environment in which the menu is displayed.

An available menu item changes with the MegaRAID Storage system that you're using.
3.2.1 Menu Bar

Selectable objects on the menu bar can also be selected/executed by right-clicking them. The menu bar appears as follows:

| File | Operations | Group Operations | Log | Tools | Help |

The menus are described below.

- **[File] menu**
  
  On the [File] menu, you can select the following items.

  - [Rescan]: Rescan the arrays to acquire the array configuration information again.
  - [Exit]: Exit from MSM.

  **IMPORTANT:** To do the rescan operation again, the interval from the previous scan should be 60 sec or longer. If the interval is shorter, an unexpected event may occur.

- **[Operations] menu**
  
  When you select the [Operations] menu, the menu displayed by right-clicking an object specified on MSM appears. The [Operations] menu changes depending on the focusing object.

- **[Group Operations] menu**
  
  On the [Group Operations] menu, you can select the following items:

  - [Check Consistency]: Execute the consistency check for logical drives. See Section "3.4.1 Executing Check Consistency" for the consistency check.
  - [Initialize]: Initialize logical drives.
  - [Show Progress]: Allows you to check the progress of the process being executed or abort the process.
- **[Log] menu**
  On the [Log] menu, you can select the following items:
  
  ![Menu Image]

  **[Save Log]:**
  
  Save the logs appearing in the Event Viewer to the specified file.

  **[Clear Log]:**
  
  Clear the logs appearing in the Event Viewer.

  **[View Saved Log]:**
  
  Allow you to view the logs saved in file with [Save Log].

- **[Tools] menu**
  This menu is not supported. **Do not use the features on this menu.**

- **[Help] menu**
  On the [Help] menu, you can select the following items:

  ![Menu Image]

  **[Help]:**
  
  Indicate the help information.
  
  But this information is not maintained. So please see this online manual instead of [Help].

  **[About]:**
  
  Indicate the version information on MSM.
3.2.2 Physical/Logical View

On the Physical/Logical View, the physical and logical drives connected to the disk array controller are displayed in the tree format, respectively.

If you put the cursor on a displayed object and right-click the object, then you can select and run an available feature. Menu displayed by right-clicking is called “Context Menu”. The contents of “Context Menu” depend on the available MegaRAID Storage Systems(SAS/SATA).

- **Menu displayed by right-clicking Controller [Context Menu]:**

  The following shows a sample menu which may be displayed by right-clicking the Controller.

  ![Controller Context Menu]

  - [Enable Alarm]:
    
    Enable the alarm feature.
    
    The alarm beeps if a fault occurs in the disk array controller. The alarm continues until you select [Silence Alarm] described later.

  - [Disable Alarm]:

    Disable the alarm feature.

    With the alarm feature disabled, the alarm does not beep if a fault occurs in the disk array controller.

  - [Silence Alarm]:

    Stop the alarm if it beeps.

  - [Start Patrol Read / Stop Patrol Read]:

    Start/stop the Patrol Read feature.

    The screen display varies depending on the execution status of the Patrol Read feature.

  - [Advanced Operations] → [Configuration]

    → [Configuration Wizard]:

      Create a logical drive. See Section "3.3.1 Creating Logical Drive" for how to create a logical drive.

    → [Add Configuration from file]:

      Recover the saved configuration.

    → [Save Configuration]:

      Save the configuration in a hard disk drive or floppy disk.

    → [Clear Configuration]:

      Clear the information on the disk array configuration.
[Scan For Foreign Config]:
Read configuration info from HDD and try to rebuild array by using that info.
This feature is not supported. **Do not use the feature.**

- **Menu appearing when right-clicking physical drive [Context Menu]:**
The menu appearing when right-clicking Physical Drive varies depending on the status of the physical drive. Sample menus are shown below in physical drive states.

**When physical drive operates normally:**

![Physical Drive Menu](image)

[Make Drive Offline]:
Make the physical drive offline.
This feature is dedicated for maintenance. Do not use the feature.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.

**When physical drive is being rebuilt:**

![Physical Drive Menu](image)

[Abort Rebuild]:
Aborts the rebuild processing.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.
When physical drive is in offline status:

[Make Drive Online]:
Makes the physical drive online.
The feature is dedicated for maintenance. Do not use the feature.

[Mark Physical Drive as Missing]:
This feature is not supported yet. Do not use the feature.

[Rebuild]:
Starts the rebuild processing.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.

When physical drive is hot-spare disk:

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.

[Remove Hotspare]:
Releases the setting as a hot-spare disk.
When physical drive is not used yet:

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.

[Make Global Hotspare]:
Create a Global hot-spare disk.

[Prepare For Removal]/ [Undo Prepare For Removal]:
Do not use the feature. It's the function which stops and restarts a revolution of a spindle motor of HDD, but these are the operation which has no need in particular in an HDD exchange.
Menu appearing when right-clicking Virtual Disk [Context Menu]:
The menu appearing when right-clicking Virtual Disk varies depending on the status of the logical drive. Sample menus are shown below in logical drive states.

**When logical drive operates normally:**

- [Delete Virtual Disk]:
  
  Select this feature to delete the logical drive.

- [Locate Virtual Disk]:
  
  Start to blink LED of Physical disks consists of Virtual disk.

- [Stop Locating Virtual Disk]:
  
  Stop to blink LED of Physical disks consists of Virtual disk.

- [Check Consistency]:
  
  Check the consistency of the logical drive.

- [Advanced Operations]
  
  ➔ [Reconstruction Wizard]:
  
  Increases in the capacity of the existing array or changes the RAID level.
  
  See Section "3.7.1 Executing Reconstruction" for how to execute the reconstruction.

---

**IMPORTANT:** When you use "N8103-90" with "N8141-37", order of HDD on MSM disagree with order of HDD on "N8141-37". In this case, "Locate Virtual Disk" feature can help.

---
When logical drive is degraded:

[Check Consistency] disappears to be unavailable while it is displayed if the logical drive operates normally.

When logical drive is subject to consistency check or rebuild processing:

[Delete Virtual Disk]:
Select this feature to delete the logical drive.

[Locate Virtual Disk]:
Start to blink LED of Physical disks consists of Virtual disk.

[Stop Locating Virtual Disk]:
Stop to blink LED of Physical disks consists of Virtual disk.

[Cancel Check Consistency] (only in consistency check):
Cancel the consistency check.
3.2.3 Properties /Operations/Graphical View

The Properties/Operations/Graphical view indicates the information on controllers and drives selected in the Physical/Logical View in the Properties view, the setups/executions of available features in the Operations view, and the capacities of graphical drives in the Graphical view.

- **Properties**
  Indicate the information on selected controllers and drives.

- **Operations**
  Allows you to set or execute features available for the selected controllers and drives.

**IMPORTANT:** Setup/execution of feature

In the setup/execution of a feature on the Operations view, select the desired feature from the menu shown to the left, change the setting on the window shown to the right if necessary and select [Go].

The menu displayed in the Operations view varies depending on the states of the selected objects and/or drives. Sample menus are shown below.

**When controller is selected:**

![Controller Menu Example]

- **[Enable Alarm]:**
  Enable the alarm feature.

- **[Disable Alarm]:**
  Disable the alarm feature.

- **[Silence Alarm]:**
  Stop the alarm when it beeps.

- **[Flash Firmware]:**
  Update the firmware of the controller.
  This operation is dedicated for maintenance. Do not use the feature.

- **[Set Patrol Read Properties]:**
  Allow you to set the Patrol Read schedule. See Section "3.5.2 Scheduling Patrol Read" for the schedule setting.
[Start Patrol Read / Stop Patrol Read]:
Start or stop the Patrol Read.
The screen display varies depending on how the Patrol Read is executed. See Section "3.5.1 Manual Execution of Patrol Read" for the execution of the Patrol Read.

[Set Adjustable Task Rates]:
Specify the preferential assignment of the system processing capacity with a value between 0% and 100% when the rebuild, Patrol Read, or check consistency feature is executed. Specifying a higher value allows the system processing capacity to be used more preferentially. Specifying a lower value causes the system performance during rebuild to remain only in a lower level. This only sets the priority against other processes. With 0%, the feature can also operate. Similarly, With 100%, any other processes are not always interrupted.

When physical drive is selected (in normal state):

[Make Drive Offline]:
Make the physical drive offline.
This feature is dedicated for maintenance. Do not use the feature.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.
When physical drive is selected (under rebuild processing):

[Abort Rebuild]:
Abort the rebuild processing.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.

When physical drive is selected (in offline status):

[Make Drive Online]:
Make the physical drive online.
This feature is dedicated for maintenance. Do not use the feature.

[Mark Physical Drive as Missing]:
This feature is not supported yet. Do not use the feature.

[Rebuild]:
Start the rebuild processing.

[Locate Physical Drive]:
Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
Stop to blink LED of Physical disk.
When physical drive is selected (being hot-spare disk):

[Remove Hotspare]:
   Release the setting as a hot-spare disk.

[Locate Physical Drive]:
   Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
   Stop to blink LED of Physical disk.

When physical drive is not used yet:

[Locate Physical Drive]:
   Start to blink LED of Physical disk.

[Stop Locating Physical Drive]:
   Stop to blink LED of Physical disk.

[Make Global Hotspare]:
   Create a Global hot-spare disk.

[Make Dedicated Hotspare]:
   Create a hot-spare disk operating only for the specified array.
[Prepare For Removal]/ [Undo Prepare For Removal]:

Do not use the feature.

It's the function which stops and restarts a revolution of a spindle motor of HDD, but these are the operation which has no need in particular in an HDD exchange.

When logical drive is selected (in normal state):

[Delete Virtual Disk]:

Select this feature to delete the logical drive.

[Locate Virtual Disk]:

Start to blink LED of Physical disks consists of Virtual disk.

[Stop Locating Virtual Disk]:

Stop to blink LED of Physical disks consists of Virtual disk.

[Check Consistency]:

Check the consistency of the logical drive.

[Start Initialization]:

Initialize the logical drive.

[Set Virtual Disk Properties]:

Allows you to set the read and/or write policies of the logical drive.

When logical drive is selected (in degrading or under rebuild processing):

[Check Consistency] and [Start Initialization] is disabled (removed from the menu) in the above screen.
When logical drive is selected (in execution of consistency check):

[Delete Virtual Disk]:
Select this feature to delete the logical drive.

[Locate Virtual Disk]:
Start to blink LED of Physical disks consists of Virtual disk.

[Stop Locating Virtual Disk]:
Stop to blink LED of Physical disks consists of Virtual disk.

[Cancel Check Consistency]:
Cancel the consistency check.

[Set Virtual Disk Properties]:
Allows you to set the read and/or write policies of the logical drive.
- **Graphical View**

Indicate the capacity of the selected drive graphically.

The following shows the sample displays of physical and logical drives.

**Sample display of physical drive**

If you select a logical drive from the [Select Virtual Disk (VD)] list as shown to the left in the figure below, you can check the area in which physical drives are used for the selected logical drive as shown to the right in the figure.

![Sample display of physical drive](image)

**Sample display of logical drive**

![Sample display of logical drive](image)
3.2.4 Event Viewer

The Event Viewer indicates the log information acquired in the period from the time at which the server is started.

- Right-click the Event Viewer.

  ![Event Viewer Interface]

  - **[Save Log]:**
    Save the logs appearing in the Event Viewer to the file.
  
  - **[Clear Log]:**
    Clear the logs appearing in the Event Viewer.
  
  - **[View Saved Log]:**
    Allow you to view the logs saved by selecting [Save Log].

**NOTES:**

There are two types of logs on MSM log viewer.

xxxxxx seconds from reboot : "Progress time since rebooting"

MSM logs are registered by following rules.
- Events which occurred after to finish OS started are shown as "Actual time"
- Events which occurred before to finish OS starting are shown as "Progress Time".

Check the application logs of system event logs, if you want to know "Progress time" as "Actual time".

"Date/Time" of log is sometimes shown by the MegaRAID Storage system that you're using to "Actual time" by "Progress time since rebooting".
Please confirm the date and time by application log in this case.
3.3 Creating and Deleting Logical Drive (Array)

The creation method of a logical drive and the deletion method are explained here. If you create logical drives, do not reuse failure HDDs. Please always use new HDDs.

MSM allows the following logical drives to be created:

- RAID 0 (data striping with more than one hard disk drive)
- RAID 1 (data mirroring with two hard disk drives)
- RAID 5 (Data striping including parity with more than two hard disk drives)
- RAID 1 spanning (Same as RAID10. Data mirroring and striping with more than three hard disk drives)
- RAID 5 spanning (Same as RAID50. Data striping including parity and striping with more than five hard disk drives)

NOTES:

Do not use the following hard disk drives to create a logical drive.

- Hard disk drive with partitions
- Hard disk drive used for another array

While a logical drive is created, system shutdown and insertion/removal of a hard disk drive are not permitted till the creation process is completed.

Available RAID level depends on MegaRAID Storage System. Please check "4.1 Supported function of MegaRAID Systems" for more detail.
3.3.1 Creating Logical Drive

You can create a logical drive on the Configuration Wizard appearing by right-clicking the controller in the Physical/Logical View and clicking [Advanced Operations] → [Configuration] → [Configuration Wizard].

As the configuration type, you can select any of Auto Configuration, Manual Configuration or Guided Configuration.

[Auto Configuration]:

The auto configuration mode allows the draft of the logical drive configuration to be created automatically depending on the status of unused hard disk drives.

[Manual Configuration]:

The manual configuration mode allows a logical drive to be created according to a specific request.

[Guided Configuration]:

The guided configuration mode allows a logical drive to be created by specifying setting items sequentially.

The selection buttons commonly displayed on the logical drive creation screen are as follows:

[CANCEL]: Cancels the logical drive creation process.
[BACK]: Returns to the previous sheet.
[NEXT]: Goes to the next sheet.
[FINISH]: Creates a logical drive.

The following sections describe the logical drive creation procedures in different configurations.
3.3.1.1 Auto Configuration

The auto configuration mode allows the draft of the logical drive configuration to be created automatically depending on the status of unused hard disk drives.

The setting procedure is described below.


![Auto Configuration](image)

2. The array configuration draft is created automatically.

For redundant array configuration, select [With Redundancy] in [Redundancy Type].

To edit the array configuration, click [Modify].

The menu appearing at the selection of [Modify] is the same as that in Step 3 of the manual configuration. See Step 3 in the manual configuration for how to change the setting.

![Configuration Wizard](image)

Initialization Type

[No Initialization]:

Do not initialize the logical drive after it is created. Do not specify this option.

[Fast Initialization]:

Do Simple initialization. This option initialize the management information of array, only.

[Full Initialization]:

Initialize the logical drive after it is created, completely. Always use this option, if you could.
Redundancy Type
[No Redundancy]:
Do not provide redundant array configuration.
[With Redundancy]:
Provide redundant array configuration.

3. Click [Finish] to create a logical drive.

3.3.1.2 Manual Configuration

The manual configuration mode allows a logical drive to be created according to a specific request. The setting procedure is described below.


2. Select a physical drive from the Unconfigured Physical Drive List and click the button to add the physical drive to the Arrays with Available Space.
To recover the added physical drive, select the physical drive and click the button.

[Add Hotspare To]:
Set the physical disk as the hot-spare disk operating only for the specified array.

[Remove HotSpare]:
Release the setting as the hot-spare disk.

3. Click [Accept]. Then click [Next].
4. Set parameters in Virtual Disk Properties appropriately and click [Accept]. Then click [Next].

[RAID Level]:
Select the RAID level of the array.

[Size (in MB)]:
Set the capacity of the logical drive to be created.

[Volume ID]:
Leave the initial setting value unchanged.

[Volume Name]:
Specify the name of the logical drive.

[Stripe Size]:
Select the unit of data distributed to each hard disk drive configuring RAID out of 8K, 16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes.

LSI Logic Embedded MegaRAID(tm) is always 64K bytes.

[Read Policy]:
Select No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default setting is No Read Ahead.

[Default Write Policy]:
Select either Write Through or Write Back. The default setting is Write Back.

Do not change this setting on "LSI Logic Embedded MegaRAID(tm)".

NOTES:
A check box of "Use Write Through for failed or missing battery" was added to [Default Write Policy] since MSM1.14-02. The default value of "Use Write Through for failed or missing battery" is the checked state when you specify "Write Back" in [Default Write Policy]. Please set the unchecked state in this case. Even if there is a battery (iBBU), it will be "Write Trough" in the checked state.
[IO Policy]:
Select either Direct IO or Cached IO. The default setting is Direct IO.

[Access Policy]:
Select Read Write, Read Only, or Blocked. The default setting is Read Write.

[Disk Cache Policy]:
Select Unchanged, Enabled or Disabled. The default setting is Unchanged.

[Init State]:
Select the logical drive initialization procedure out of No Initialization, Fast Initialization and Full Initialization. The default setting is No Initialization.

**NOTE:** Depending on the disk array controller you use, some setting values may be restricted for stable system performance and operation. Refer to manuals coming with the Disk array controller and server for the settings previously.

5. Check the contents of the array to be configured.
After checking the contents, click [Finish]. Then the logical drive is created.
3.3.1.3 Guided Configuration

The guided configuration mode allows a logical drive to be created by specifying setting items sequentially. The setting procedure is described below.


2. Select [Redundancy] and [Existing Arrays] options and specify the number of logical drives to be created in [Desired Number of Virtual Disks]. Click [Next].

**Redundancy**

[Redundancy Only]:

Create redundant array configuration.

[Redundancy when possible]:

Try to create redundant array configuration. If not possible, creates non-redundant array configuration.

[No Redundancy]:

Create non-redundant array configuration.

**Existing Arrays**

[Use Existing Arrays Only]:

Use existing arrays only.
[Don’t use Existing Arrays]:
Do not use existing arrays.

[Use Existing and New Arrays]:
Use both existing and new arrays.

3. Specify the number of logical drives to be created for each RAID and its capacity in Virtual Disk Count and Total Capacity, respectively. Set relevant parameters in Virtual Disk Properties and click [Next].

[Stripe Size]:
Select the unit of data distributed to each hard disk drive configuring RAID out of 8K, 16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes.

LSI Logic Embedded MegaRAID(tm) is always 64K bytes.

[Read Policy]:
Select No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default setting is No Read Ahead.

[Default Write Policy]:
Select either Write Through or Write Back. The default setting is Write Back.

[IO Policy]:
Select either Direct IO or Cached IO. The default setting is Direct IO.

[Access Policy]:
Select Read Write, Read Only, or Blocked. The default setting is Read Write.

[Disk Cache Policy]:
Select Unchanged, Enabled or Disabled. The default setting is Unchanged.
[Init State]:

Select the logical drive initialization procedure out of No Initialization, Fast Initialization and Full Initialization.

The default setting is No Initialization.

**NOTE:** Depending on the disk array controller you use, some setting values may be restricted for stable system performance and operation. Refer to manuals coming with the Disk array controller and server for the settings previously.

4. Check the contents of the array to be configured.

   After checking the contents, click [Finish] to create the logical drives.

   To edit the array configuration, click [Modify].

   The menu appearing at the selection of [Modify] is the same as that in Step 3 of the manual configuration. See Step 3 in the manual configuration for setting changes.

### 3.3.2 Deleting Logical Drive

You can delete a logical drive in the following procedure:

1. Select the logical drive to be deleted in the Logical view.
2. Click [Operations] → [Delete Virtual Disk] on the menu bar.
3. A confirmation/warning message appears. Select [Yes]. Selecting [No] causes the deletion processing to be canceled.
4. The selected logical drive is deleted from MSM.

**IMPORTANT:** Any logical drive deleted by mistake cannot be recovered any more. Before deleting a logical drive, make sure that it may be deleted.
### 3.4 Check Consistency Feature

The check consistency feature checks consistency and automatically corrects data if some inconsistency is detected.

**IMPORTANT:** The Check Consistency function and the Patrol Read function allow you to find the defects (due to degradation such as aging) in files of low access frequency and unused areas as soon as possible. In rebuilding after replacement of a HDD due to a failure, subsequent defects may be found in remaining HDDs. In such a case, the system cannot be recovered. Thus, detecting subsequent defects as early as possible is extremely effective as preventive maintenance. Periodical synchronization or media patrol is effective to keep the stable operation of your system. It is strongly recommended to take the action once per week or at least once per month.

#### 3.4.1 Executing Check Consistency

The check consistency is executed in the following procedure.

**Check consistency execution procedure**

The check consistency can be executed in any of the following three ways.

- Starting execution on menu bar
- Starting execution on menu displayed by right-clicking
- Starting execution on [Operations] tab

The execution procedures in the ways are described below.

**Starting execution on menu bar**

1. Select [Group Operations] → [Check Consistency] on the menu bar.
2. Check one or more logical drives to be subject to the check consistency in [Select Virtual Disks] and click [Start].

   ![Group Consistency Check]

[Select All]:
Check all logical drives.

[Deselect All]:
Uncheck all logical drives.

3. The check consistency check is executed.

   Click the [×] button at the upper right corner of the screen to close it.

   Select [Group Operations] → [Show Progress] on the menu bar to see the progress of the execution.

**Starting execution on menu displayed by right-clicking**

1. Select a logical drive on the [Logical] tab and right-click it.

2. Select [Check Consistency] on the menu displayed by right-clicking.

   ![Logical Tab]

3. The consistency check is executed.

   Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the execution.
1. Select a logical drive on the Logical view and select the [Operations] tab.
2. Check [Check Consistency] and click [Go].
3. The consistency check is executed.
   Select [Group Operations] → [Show Progress] on the menu bar to see the progress of the execution.
3.4.2 Canceling Check Consistency

The check consistency can be cancelled in the following procedure.

Check consistency canceling procedure

1. Select [Group Operations] → [Show Progress] on the menu bar.
2. The Group Show Progress screen appears.
   Click [Abort] to the right of the progress indication.

   [Abort All]:
   With more than one logical drive being subject to the check consistency, allows the check consistency to be canceled for all the logical drives

3. Cancels the consistency check.
   Click the [×] button at the upper right corner of the Group Show Progress screen to close it.
3.5 Patrol Read Feature

The Patrol Read feature operates in physical drives configuring all arrays including hot-spare disks to detect errors and recover the system from the errors if they are detected.

**IMPORTANT:** The Check Consistency function and the Patrol Read function allow you to find the defects (due to degradation such as aging) in files of low access frequency and unused areas as soon as possible. In rebuilding after replacement of a HDD due to a failure, subsequent defects may be found in remaining HDDs. In such a case, the system cannot be recovered. Thus, detecting subsequent defects as early as possible is extremely effective as preventive maintenance. Periodical synchronization or media patrol is effective to keep the stable operation of your system. It is strongly recommended to take the action once per week or at least once per month.

3.5.1 Manual Execution of Patrol Read

The Patrol Read can be executed manually in the following procedure.

**Patrol Read execution procedure**

1. Under the selection of a controller on the Physical/Logical View, click [Operations] → [Start Patrol Read] on the menu bar.

2. If the confirmation dialog shown below appears, click [Yes].
   
   The Patrol Read is executed.
To interrupt the Patrol Read being executed, click [Operations] → [Stop Patrol Read].
3.5.2 Scheduling Patrol Read

The Patrol Read can be scheduled in the following procedure.

Patrol Read scheduling procedure

1. Select a controller on the Physical/Logical View. Then select [Operations].
2. Check [Set Patrol Read Properties].
3. The schedule setting screen shown below appears. Change the Operation Mode to [Auto].
   If [Auto] is selected already, the mode change is not required.

   ![Schedule Setting Screen]

   [Auto]:
   Execute the Patrol Read scheduling.

   [Manual]:
   Disables the execution of the scheduled Patrol Read and enables the manual execution only.

   [Disabled]:
   Disable the Patrol Read.

4. Change the following items to desired values and click [Go].

   [Maximum PD Count for patrolling]:
   Set the maximum number of physical drives for which the Patrol Read is to be executed.
   Do not change the default value (255).

   [Continuous Patrolling]:
   This feature is not supported yet. Do not check it.

   [Select Excluded Virtual Disks]:
   If you check one or more logical drives appearing in this item, the Patrol Read is not executed for the drives. To execute the Patrol Read for all logical drives, do not put checks in this option.
[Execution Frequency]:

Specify the interval at which the Patrol Read is executed.
You can set the interval in hours, minutes, or seconds.

NOTES:
If you shutdown the server on the way of manual Patrol Read, it is aborted. Execute the Patrol Read again when the server is started.

If you shutdown the server on the way of schedule Patrol Read, it will be restarted from the beginning at the next start of the server.
3.6 Rebuild Feature

The rebuild feature can recover a degraded array. Before the feature can be used, the defected hard disk drive must be replaced with a normal hard disk drive.

The rebuild can be done in the following three ways.

[Hot-swap rebuild]:
This method provides rebuild by replacing a hard disk drive defected during system operation with a normal hard disk drive.

[Hot-spare rebuild]:
This method previously creates a hot-spare disk and starts rebuild by using the spare disk automatically when a hard disk drive is defected.

Hot-spare disks include the following two types.

- Global Hot-spare
  Hot-spare disks of the type are used to operate for all arrays.
- Dedicated Spare
  Hot-spare disks of the type are used to operate for specified arrays.

[Rebuild from MSM]:
The feature starts rebuild by selecting [Rebuild] displayed by right-clicking the defected hard disk drive. Because the feature uses the defected hard disk drive to try array recovery, the rebuild may fail or the array may be degraded immediately after it can be recovered.

Accordingly, it cannot secure the operation after the rebuild.

The hot-swap and hot-spare rebuild operations are described below.

NOTES:
Do not use the hot-swap feature during array rebuild operation.

To enable rebuild, the disk capacity of the new hard disk drive should be equal to or larger than the disk capacity of the defected hard disk drive.
3.6.1 Hot-swap Rebuild

The feature can be done in the following procedure:

1. Find the defected hard disk drive. The following figure shows a sample display in MSM.

![Sample Display in MSM]

The icon shows a degraded logical drive. The icon shows a defected hard disk drive.

2. Pull out the defected hard disk drive.

3. Insert a normal hard disk drive into the slot from which the defected hard disk drive is pulled out. After the insertion, the rebuild operation is started.

![Hard Disk Drive Being Rebuilt]

The icon shows the hard disk drive being rebuilt.

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the execution.

**IMPORTANT:** For the replacement of a hard disk drive by using the hot-swap feature, the interval from the removal of the defected hard disk drive to the installation of a substitute hard disk drive should be 60 sec or longer. A shorter interval may cause an unexpected event to occur. (It is recommended to go to the next step after the removal and installation can be recognized on MSM.)
3.6.2  Hot-spare Rebuild

3.6.2.1  Hot-spare Disk Setting Procedure

Global hot-spare setting procedure

1. Specify an unused hard disk drive shown on the Physical view and right-click it.
3. The hard disk drive is shown to be a hot-spare disk.

Dedicated hot-spare setting procedure

1. Select an unused hard disk drive shown on the Physical view. Then select [Operations].
2. Check [Make Dedicated Hotspare].
3. The array selection screen shown below appears. Check the array to be operated dedicatedly in Select array and click [GO].

![](image)

**IMPORTANT:** As a hot-spare disk, use a drive having a capacity larger than or equal to that of the hard disk drive configuring the array. If the hard disk drive has only a lower capacity, the hot-spare build feature cannot be operated.

3.6.2.2  Release of Hot-spare Disk Setting

1. Select a hot-spare disk and right-click it.
2. Select [Remove Hotspare] from the menu displayed by right-clicking the hot-spare disk.
3. The confirmation message appears. Select [Yes]. If you select [No], the release processing is cancelled.
4. The hot-spare disk setting is released. The released disk will be an unused hard disk drive.
3.7 Reconstruction Feature

The reconstruction feature allows you to increase in the capacity of an existing array and/or change its RAID level.

IMPORTANT:

Execution of reconstruction
It is recommended that the partitions on a logical drive are always backed up before the addition of the capacity of the array so that proper measures can be taken at the occurrence of an unexpected event.

Any reconstruction cannot be cancelled after it is started.

NOTE: The reconstruction feature is only available only under the following condition:

Only a single logical drive should be configured in the array (the reconstruction feature is unavailable if more than one logical drive are configured in the array).

3.7.1 Executing Reconstruction

To execute the reconstruction, right-click the relevant logical drive on the Logical view, click [Advanced Operations] → [Reconstruction Wizard] and select [Yes] for the confirmation message shown below to display the Reconstruction Wizard.

The Reconstruction Wizard can also be displayed by selecting the relevant logical drive on the Logical view and clicking [Operations] → [Advanced Operations] → [Reconstruction Wizard] on the menu bar.
The reconstruction is divided into three types; Add Drive, Remove Drive and Change RAID Level.

[Add Drive]:
Add a physical drive to the logical drive to increase in the capacity of the array.

[Remove Drive]:
Removes the physical drive from the logical drive and converts the RAID level to RAID 0.

[Change RAID Level]:
Convert the RAID level to RAID 0.

The reconstruction procedures in types are described below.

### 3.7.1.1 Add Drive

This feature adds a physical drive to the logical drive to increase in the capacity of the array.
The procedure is described below.

2. Select the physical drive to be added from the upper list and click the button to move the physical drive to the lower list. Then click [Next].

3. The physical drive to be added appears with red characters. Select the RAID level after the expansion from [New RAID Level] and click [Finish].

4. The confirmation message appears. Select [Yes]. If you select [No], the Add Drive feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the execution.

**IMPORTANT:** Specify only a single HDD in the execution of Add Drive. If more than one HDD must be specified, first complete the addition of a single HDD and then start the Add Drive feature again.

"Add Drive" feature increase capacity of array, but do not increase capacity of partition which recognize by OS. If you want to increase partition size, you need to make partition newly after "Add drive". It is recommended that the partitions on a logical drive are always backed up before remake partitions.
3.7.1.2 Remove Drive

This feature removes the physical drive from the logical drive and converts the RAID level to RAID 0. The procedure is described below.

1. Click [Remove Drive] in Reconstruction Mode of the Reconstruction Wizard.

2. Select the physical drive to be removed from the upper list and click the button to move the physical drive to the lower list. Then click [Next].

3. The physical drive to be removed appears with red characters. After checking the information, click [Finish].

4. The confirmation message appears. Select [Yes]. If you select [No], the Remove Drive feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the execution.
3.7.1.3 Change RAID Level

This feature converts the RAID level to RAID 0.

The procedure is described below.

1. Click [Change RAID Level] in Reconstruction Mode of the Reconstruction Wizard.

2. Select RAID 0 from New RAID Level and click [Finish].

3. The confirmation message appears. Select [Yes]. If you select [No], the Change RAID Level feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the execution.
3.8 Help

Selecting [Help] → [Help] on the menu bar allows the help normally attached to MSM to be displayed.

**NOTE:** The help normally attached to MSM includes the features unsupported by the NEC Express5800 series machines and the features on array boards unsupported by the NEC Express5800 series servers. See the relevant descriptions in this manual for the supported features.

Version confirmation procedure

Selecting [Help] → [About] on the menu bar allows you to see the MSM version. If you select [Server Info], the information on the server appears as shown below.
4. Miscellaneous Information

4.1 Supported function of MegaRAID Systems

Supported function of MSM depends on the MegaRAID Systems. See below for detail.

**Remarks**

MegaRAID Systems

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>√: Supported.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function (*1)</th>
<th>Embedded MegaRAID</th>
<th>N8103-90/91</th>
<th>N8103-99</th>
<th>N8403-019</th>
<th>ROMB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation of GUI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Bar</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Physical/Logical View</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Properties/Operations/Graphical View</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Events Viewer</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Supported Array Level (*2)</td>
<td>0, 1, 10</td>
<td>0, 1, 10, 5, 50</td>
<td>0, 1, 10, 5, 50</td>
<td>0, 1</td>
<td>0, 1, 10, 5, 50</td>
</tr>
<tr>
<td>Making &amp; Delete Logical Drives</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Check Consistency</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Patrol Read</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Operation</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Scheduled Operation</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Rebuild</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hot Swap Rebuild</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Hot Spare Rebuild</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Hot Spare</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Hot Spare</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Dedicated Hot Spare</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical Disk</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate Physical Drive</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Logical Disk</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate Virtual Disk</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Reconstruction Wizard</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Flash Firmware</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Browse &amp; Save Logs</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Remote Function</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>

*1: Depends on RAID driver or RAID firmware.
*2: Depends on Server.
4.2 How to confirm the type of Hot Spare Disks

You could confirm the type of Created Hot Spare Disks by MSM.

There are 2 type of Hot Spare Disk, "Global Hot Spare Disk" and "Dedicated Hot Spare Disk".

**How to confirm**

- Global Hot Spare Disk
  
  "Global Hot Spare Disk" is shown on Physical View, but not shown on Logical View.

- Dedicated Hot Spare Disk
  
  "Dedicated Hot Spare Disk" is shown on both of Physical and Logical View.

**Sample**

1. Start up MSM.

2. Show Physical View. Check Hot Spare Disk icon ( ).
   
   There are 2 type of Hot Spare Disk, "Global Hot Spare Disk" and "Dedicated Hot Spare Disk" (marked red frame).

3. Show Logical View. Check Hot Spare Disk icon ( ). There is only "Dedicated Hot Spare Disk" (marked red frame).
5. CAUTIONS AND RESTRICTIONS

5.1 Common Cautions and Restrictions for MegaRAID Storage Systems(SAS/SATA)

Installing / uninstalling of MSM
- MSM temporarily uses a dynamic port number (49152 or above) during installation. MSM automatically releases the port at the end of installation.
- If MSM is installed in a computer in which OS supporting Windows firewall such as Windows XP is installed, the "Important warning on Windows security" window may appear against "javaw" at the start of MSM. If this occurs, select [Remove block].
- Windows Security Warning may be shown about “POPUP” when installing MSM. This POPUP module is disabled in the installer of MSM, so there is no problem. The warning message is no longer shown after system reboot.
- The dialog of "warning of security" may be displayed during the process of "Standby/Hibernation Lock" driver installation at MSM installation. In this case, select "Yes" to continue the installation.
- To control MSM by a remote computer, MSM must be installed in both local and remote computers.
- Popuplog.log file is created in C: drive at the time of MSM installation. This file is not used after the reboot, so this file is able to remove after the reboot.

MSM operation
- MSM client can not be started until MSM related service completes a start. When having started a MSM client before starting service, the next error is indicated. "Fatal Eror:Cannot connect to Framework!"
  MSM related service is the following.
  - Service Name: MegaMonitorSrv, Display Name: MRMonitor
  - Service Name: MSMFramework, Display Name: MSMFramework
- If you select [Replace Missing Physical Drive] in [Operations], a pull-down menu without options appears in the right frame. Do not use the feature.
- The firewall function which is provided by Windows OS disturbs the remote function of MSM. Change the setting for the remote function of MSM. Review the port setting for the firewall.
- MSM uses port numbers 3071 and 5571. You cannot change these port numbers.
- MSM uses any port numbers 32000 over temporarily.
- Concurrent accesses by both MSMs in local and remote computers are possible. However, only a single MSM can have the full access authority. If the full access authority cannot be selected in the login mode, check whether an access from another client occurs.
The MSM log may be reviewed to see accesses from other clients.

- You can specify the local users only as the Administrators member in the "User Name" field of MSM login window. You can not specify domain users which has Administrators right.
- MSM cannot be used when there is no MegaRAID Storage System in the same LAN.
- MSM cannot be used when the target server has several ports which are belonged to different sub-net. In this case, please use MSM in the target server.
- To do the rescan operation again, the interval from the previous scan should be 60 sec or longer. If the interval is shorter, an unexpected event may occur.
- Do not use the "Prepare For Removal" and "Undo Prepare For Removal". It is the function that stops and restarts a spinning of spindle motor of HDD, however, these are the operations which are no need in particular to replace HDDs.
- A check box of "Use Write Through for failed or missing battery" was added to [Default Write Policy] since MSM1.14-02. The default value of "Use Write Through for failed or missing battery" is the checked state when you specify "Write Back" in [Default Write Policy]. Please set the unchecked state in this case. Even if there is a battery (iBBU), it will be "Write Through" in the checked state.

Creating or deleting logical drive

- Specify the maximum capacity (default value) for RAID 1 spanning (RAID 10) or RAID 5 spanning (RAID 50) if a logical drive is created with the capacity specified. Do not change the capacity.
- In creation of a logical drive, do not use the following hard disk drives.
  - Hard disk drive with partitions
  - Hard disk drive used for another array
- While a logical drive is being created, do not perform the followings:
  - Shut down the system
  - Insert hard disk drive(s)
  - Remove hard disk drive(s)

Rebuild feature

- Do not use the hot-swap feature during rebuild.
- In the rebuild operation by using the hot-swap feature, the interval from the removal of the hard disk drive to the installation of a substitute hard disk drive should be 60 sec or longer.
- Hard disk drives in the status shown below cannot be used as hot-spare disks. Instead, use new hard disk drives or hard disk drives already formatted.
  - Hard disk drive with partitions
  - Hard disk drive used for another array
Patrol Read feature

- If the server is restarted, the Patrol Read feature is aborted. If you restart the Patrol Read after restarting the server, it will be executed from the first step.
- Even when selecting "Stop Patrol Read" and making them suspend a patrol lead on the way, it indicates "Complete".

Miscellaneous

- It is recommended that "Check Consistency" or "Patrol Read" is periodically performed to detect defects due to the fails of HDDs.
- Note that the icons of events reported by the NEC ESMPRO report feature are all displayed green on NEC ESMPRO (they seem information events).
- If the [Save] dialog is displayed by selecting [Save Log] on the [Log] menu, the [Desktop] folder is displayed incorrectly in Japanese Environment. To save a log, specify a folder other than [Desktop].
- To start MSM, the screen setting should be done so that more than 255 colors are available. If only up to 255 colors are available, the relevant error message appears and MSM cannot be started.
- If you display the dialog for [Save Log] and select [Detail], the information on [Type] will be garbled in Japanese environment. To check [Type] to be displayed in the save log operation, use Windows Explore.
- When restarting MSM, the messages displayed in the MSM screen may disappear. Use the [Save Log] feature of MSM or check the messages registered in the Windows application log.
- In case user wants to change the IP of the server system, MSMFramework Service needs to be restarted.
5.2 Cautions and Restrictions for N8103-90 Disk array controller (External SAS HDD) and N8103-91 Disk array controller (Internal SAS HDD)

MSM Operation

- "Date/Time" of MSM Logs is sometimes shown as "xx seconds from reboot". In this case, please check the Application Log of System Events.

- Every time MSM is started when an additional battery (N8103-94) is not attached with, the next message is output by MSM log and event log (application). Even if Write Thru is set in Write Policy, this is output.

```
[ MSM Log ]
Controller ID:x BBU disables; changing WB logical drivers to WT.
[ Event Log(Application) ]
Source : MR_MONITOR
Event ID : 195
  x is controller ID number.

It can be restrained by this log printout's inputting 'D' with the next message indicated at the time of a server start.

The battery hardware is missing or malfunctioning, or the battery is unplugged. If you continue to boot the system, the battery-backed cache will not function. Please contact technical support for assistance.

Press 'D' to disable this warning (if your controller does not have a battery).
```

- If redundant power unit is not installed to "N8141-37 Disk Expansion Unit", the following popup message may be shown up while installing MSM. And you may see the following event in MSM and application event logs at every boot time. However those are no problem.

```
[ MSM Log ]
Controller ID:x BBU disables; changing WB logical drivers to WT.
[ Event Log(Application) ]
Source : MR_MONITOR
Event ID : 173
  x is controller ID number.
```

- When using N8141-37F Disk Expansion Unit which is connected to N8103-90F Disk Array Controller, it is necessary to check the slot numbers of drives before you use configuration wizard, rebuild feature or reconstruction feature.

  - The slot numbers are not displayed while executing the features and you need to select physical drive numbers of drives. Note that physical drive numbers which are displayed in the left panel of physical view may be different from the actual slot numbers of drives. You can see the slot numbers in the Properties view of drives on MSM such as the following copy of the screen.

```
[ MSM Log ]
Controller ID:x BBU disables; changing WB logical drivers to WT.
[ Event Log(Application) ]
Source : MR_MONITOR
Event ID : 173
  x is controller ID number.
```

  - The slot numbers are started from 0, although those printed on the unit are started from 1.
• To avoid selecting wrong drives, it is highly recommended to check them properly by executing ‘Locate Physical Drive’ or ‘Locate Virtual Disk’ operation on MSM.
5.3 Cautions and Restrictions for LSI Logic Embedded MegaRAID™

**MSM Operation**

- MSM cannot set "Virtual Disk Properties" for several "Virtual Disks" at the same time. If you want to set "Virtual Disk Properties" to the second Virtual Disk and all subsequent Disks, select "Rescan" to refresh the display.
- "Progress display" and "HDD icon" cannot be updated automatically, when "Rebuild" is done by RAID10. Please use "Rescan" feature as workaround.
- "Dedicated Hotspare" is not supported with MSM on "LSI Logic Embedded MegaRAID(tm)" environment, even if it is on the menu.

**Making & Removing of Logical Drives**

- When you make "Virtual Disk" by "Configuration Wizard", "Disk Cache Policy" is set to the value dependent on "Write Policy".
- MSM cannot delete "Virtual disk" during "Rebuilding" and "Checking Consistency".
- Do not change "Default Write Policy" with "
- 
- Manual Configuration" or "

Guided Configuration".

Miscellaneous

- MSM logs are shown as GMT. The system event logs are shown correctly by local time. If you use the sort feature of MSM logs, restart MSM to display logs in order of time.
- Task Rates is not supported.
- When you change the name of "Virtual Disk", MSM display can not be refreshed. In this case, no message is registered.
- When detecting an ECC error by "Check Consistency ", "Media Error Count" is not refreshed automatically. Please use "Rescan" in this case.
- In the Windows XP 64bit environment, "Windows 2003" is displayed in the field of "OS name" in the server selection screen and property display on the MSM.
Appendix A  Report Monitoring

Event messages associated with the MegaRAID Storage system can be displayed on the NEC
ESMPRO Manager. The setting varies depending on the environment as follows:

- To monitor messages with the NEC ESMPRO Manager operating on a machine other
  than the server to which the monitored MegaRAID is connected, take the following
  procedure on the machine.
- To monitor messages with the NEC ESMPRO Manager operating on the server to which
  the monitored MegaRAID is connected, no setup is required.

Alert report registry setup procedure

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive. If the [Master
   Control] menu appears on the screen, close the menu.
   Install the MSM manually with the CD which attached the SAS Card, when there is no
   MSM installer in the "EXPRESSBUILDER" CD.

2. Start "MSMALTEN.EXE" in "\MSM\" of NEC EXPRESSBUILDER.
   Start "MSMALTEN.EXE" in "\MSM\", when you use the CD which attached the SAS Card,
   also.
   The confirmation dialog box appears. Select [Yes].

3. After the registry setup is completed, the dialog box indicating the termination appears.
   Click [OK] to reboot the system.
Alert report messages and actions against the messages

If MSM is installed, the following messages registered as "MSM" are set as report targets. To change the setting, redefine it by the NEC ESMPRO Agent report setup procedure.

To change the setting, redefine it by the NEC ESMPRO Agent report setup procedure.

The event IDs in the table below are decimal numbers. Mark "√" in the Manager column indicates the transmission of the report to NEC ESMPRO Manager. Mark "√" in the Alive column indicates the transmission of the report to the express report service. Every report is sent as information.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Message</th>
<th>Action</th>
<th>Manager</th>
<th>Alive</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Unable to recover cache data from TBBU</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Controller cache discarded due to memory/battery problems</td>
<td>Check the memory and battery.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Unable to recover cache data due to configuration mismatch</td>
<td>Replace the disk array controller.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Controller cache discarded due to firmware version incompatibility</td>
<td>Replace the disk array controller.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Fatal firmware error: A firmware error occurs. Replace the disk array controller.</td>
<td></td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Flash downloaded image corrupt</td>
<td>The flash image may be damaged. Check the flash image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Flash error</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Flash programming error</td>
<td>Check the media used for flash. If the media are not defected, replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Flash timeout during programming</td>
<td>Check the media used for flash. If the media are not defected, replace the disk array controller.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Flash chip type unknown</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Flash command set unknown</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Flash verify failure</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Multi-bit ECC error: If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Single-bit ECC error: If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Not enough controller memory</td>
<td>Take the replacement of the disk array controller into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Background Initialization aborted on VD:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Background Initialization corrected medium error:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Background Initialization completed with uncorrectable errors on VD:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Background Initialization detected uncorrectable multiple medium errors:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Background Initialization failed on VD:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Consistency Check aborted on VD:</td>
<td>The consistency check is aborted. Check the validity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Event Description</td>
<td>Recommended Action</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------------------</td>
<td>--------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Consistency Check corrected medium error:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Consistency Check detected uncorrectable multiple medium errors:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Consistency Check failed on VD:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Consistency Check failed with uncorrectable data on VD:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Consistency Check found inconsistent parity on VD strip:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Consistency Check inconsistency logging disabled, too many inconsistencies on VD:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>Initialization aborted on VD:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>Initialization failed on VD:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>Reconstruction stopped due to unrecoverable errors:</td>
<td>If the error recurs, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>76</td>
<td>Reconstruct detected uncorrectable multiple medium errors:</td>
<td>If the error recurs, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>79</td>
<td>Reconstruction resume failed due to configuration mismatch:</td>
<td>If the error recurs, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>82</td>
<td>PD Clear aborted:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>83</td>
<td>PD Clear failed:</td>
<td>If the error recurs, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>87</td>
<td>Error:</td>
<td>Contact the support department.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Hot Spare SMART polling failed:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>92</td>
<td>PD is not supported:</td>
<td>Check whether a supported physical drive is inserted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>Patrol Read corrected medium error:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td>Patrol Read found an uncorrectable medium error:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96</td>
<td>PD Predictive failure:</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97</td>
<td>Puncturing bad block:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>98</td>
<td>Rebuild aborted by user:</td>
<td>The rebuild is aborted by some user operation. Build RAID again.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td>Rebuild complete on VD</td>
<td>This message is rebuilding completion notification. The action is unnecessary.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Rebuild complete on PD</td>
<td>This message is rebuilding completion notification. The action is unnecessary.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Rebuild failed due to source drive error:</td>
<td>The source physical drive may be damaged. Take the replacement of the physical drive and the recovery from the backup into account.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Recommendation</td>
<td>CAUTIONS AND RESTRICTIONS</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>Rebuild failed due to target drive error:</td>
<td>The target physical drive may be damaged. Take the replacement of the physical drive into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>105</td>
<td>Rebuild started:</td>
<td>This message is rebuilding starting notification. The action is unnecessary.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>Rebuild automatically started:</td>
<td>This message is rebuilding starting notification. The action is unnecessary.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>Rebuild stopped due to loss of cluster ownership:</td>
<td>Check the authority.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>Reassign write operation failed:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>Unrecoverable medium error during rebuild:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>111</td>
<td>Unrecoverable medium error during recovery:</td>
<td>If the error occurs frequently, take the preventive replacement of physical drives into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>119</td>
<td>SAS topology error: Loop detected</td>
<td>Check the connection of the disk array controller.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>120</td>
<td>SAS topology error: Device not addressable</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>121</td>
<td>SAS topology error: Multiple ports to the same SAS address</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>122</td>
<td>SAS topology error: Expander error</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>123</td>
<td>SAS topology error: SMP timeout</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>124</td>
<td>SAS topology error: Out of route entries</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>SAS topology error: Index not found</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>126</td>
<td>SAS topology error: SMP function failed</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>127</td>
<td>SAS topology error: SMP CRC error</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>128</td>
<td>SAS topology error: Multiple subtractive error</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>129</td>
<td>SAS topology error: Table to table</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>SAS topology error: Multiple paths</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>131</td>
<td>Unable to access device</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>134</td>
<td>Dedicated Hot Spare no longer useful for all arrays</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>137</td>
<td>Global Hot Spare does not cover all arrays</td>
<td>Take the preventive replacement of physical drives into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>VD Marked inconsistent due to active writes at shutdown:</td>
<td>Check the consistency for confirmation.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>Battery temperature is high</td>
<td>The battery is heated at a high temperature. If the error occurs frequently, take the battery replacement into account.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>146</td>
<td>Battery voltage low</td>
<td>If the error occurs frequently, take the battery replacement into account.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>Battery is discharging</td>
<td>If the error occurs frequently, take the battery replacement into account.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Battery needs to be replaced, SOH Bad</td>
<td>Replace the battery.</td>
<td>✓  ✓</td>
<td></td>
</tr>
<tr>
<td>154</td>
<td>Battery releam timed out</td>
<td>Replace the battery.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>162</td>
<td>Current capacity of the battery is below threshold</td>
<td>If the error occurs frequently, take the battery replacement into account.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>166</td>
<td>Communication lost on enclosure:</td>
<td>Check the connection of the enclosure.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>167</td>
<td>Fan failed on enclosure:</td>
<td>Check the operation of the enclosure fan.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>168</td>
<td>Fan removed on enclosure:</td>
<td>Check the connection of the enclosure fan.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>169</td>
<td>Power supply failed on enclosure:</td>
<td>Check the power supply of the enclosure.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>170</td>
<td>Temperature sensor below warning threshold on enclosure:</td>
<td>The temperature sensor exceeds the warning threshold. Check the temperature.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>171</td>
<td>Temperature sensor below error threshold on enclosure:</td>
<td>The temperature sensor exceeds the error threshold. Check the temperature.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>172</td>
<td>Temperature sensor above warning threshold on enclosure:</td>
<td>The temperature sensor exceeds the warning threshold. Check the temperature.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>173</td>
<td>Temperature sensor above error threshold on enclosure:</td>
<td>The temperature sensor exceeds the error threshold. Check the temperature.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>174</td>
<td>Power supply switched off for enclosure:</td>
<td>Check the power of the enclosure.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>175</td>
<td>Power supply cable removed on enclosure:</td>
<td>Check whether the power cable of the enclosure is disconnected.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>176</td>
<td>Enclosure shutdown:</td>
<td>Check the enclosure.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>177</td>
<td>Too many enclosures connected to port. Enclosure not supported:</td>
<td>Decrease the number of connected enclosures.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>178</td>
<td>Firmware mismatch on enclosure:</td>
<td>The compatibility with the firmware of the enclosure is disabled. Contact the support department.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>179</td>
<td>Sensor bad on enclosure:</td>
<td>Contact the support department.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>Phy is bad on enclosure:</td>
<td>The enclosure may be defected. Take the replacement into account.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>181</td>
<td>Unstable Enclosure:</td>
<td>The enclosure may be defected. Take the replacement into account.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>182</td>
<td>Hardware error on enclosure:</td>
<td>The enclosure may be defected. Take the replacement into account.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>183</td>
<td>No response from enclosure:</td>
<td>The enclosure may be defected. Take the replacement into account.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>184</td>
<td>SAS/SATA mixing not supported in enclosure; disabled PD:</td>
<td>SAS and SATA coexist in a specific enclosure. Check whether the connection is configured correctly.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>185</td>
<td>Unsupported hotplug was detected on SES enclosure:</td>
<td>The hot-plug is not supported.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>186</td>
<td>BBU disabled; changing WB logical drives to WT:</td>
<td>Check the battery.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>187</td>
<td>Bad block table is 80% full on PD:</td>
<td>The bad block table in the physical drive is filled by 80% or larger. Replace the physical drive.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>188</td>
<td>Bad block table is full; unable to log block:</td>
<td>The bad block table in the physical drive is full. Replace the physical drive.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>189</td>
<td>Consistency Check Aborted Due to Ownership Loss on VD:</td>
<td>Check the authority.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Background Initialization (BGI) aborted due to ownership loss on VD:</td>
<td>Check the authority.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>191</td>
<td>Battery/charger problems detected; SOH Bad</td>
<td>Replace the battery.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>192</td>
<td>Single-bit ECC error; warning threshold exceeded:</td>
<td>Take the preventive replacement of the physical drive into account.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>193</td>
<td>Single-bit ECC error; critical threshold exceeded:</td>
<td>Replace the physical drive.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>194</td>
<td>Power supply switched off for enclosure:</td>
<td>Check the power of the enclosure.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>195</td>
<td>Power supply cable removed on enclosure:</td>
<td>Check whether the power cable of the enclosure is disconnected.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>196</td>
<td>BBU Retention test failed!</td>
<td>Replace the BBU.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>197</td>
<td>NV/RAM Retention test failed!</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>CAUTIONS AND RESTRICTIONS</td>
<td>73</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>----</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>216 FAILED Test:</td>
<td>The test detects an error. Take the replacement of the disk array controller into account.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>221 NVRAM is corrupt; reinitializing</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>222 NVRAM mismatch occurred</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>223 Link lost on SAS wide port:</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>225 Allowed error rate exceeded on SAS port:</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>226 Bad block reassigned:</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>228 Temperature sensor differential detected on enclosure:</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>229 Disk test cannot start. No qualifying disks found</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>230 Time duration provided by host is not sufficient for self check</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>235 Firmware download failed on enclosure:</td>
<td>If the error occurs frequently, take the preventive replacement of the disk array controller into account.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>236 Drive is not certified:</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>238 PDs missing from configuration at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>239 VDs missing drives and will go offline at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>240 VDs missing at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>241 Previous configuration completely missing at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>245 PD rebuild not possible as SAS/SATA is not supported in an array</td>
<td>Check whether physical drives to be supported are used.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250 VD is now PARTIALLY DEGRADED</td>
<td>Partial degrading is detected. Replace the defected physical drive and run the rebuild operation.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>251 VD is now DEGRADED</td>
<td>The logical drive is degraded. Replace the defected physical drive and run the rebuild operation.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>252 VD is now OFFLINE</td>
<td>The logical drive enters into the offline status. Recover the data by using the backup.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>254 VD disabled because RAID-5 is not supported by this RAID key</td>
<td>Please check the RAID key.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>255 VD disabled because RAID-6 is not supported by this controller</td>
<td>Please check the RAID key.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>256 VD disabled because SAS drives are not supported by this RAID key</td>
<td>Please check the SAS driver and the RAID key.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>257 PD missing</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>